Chapter 1
Introduction

During my years of teaching SketchUp, as well as other Computer-Aided Design (CAD) and Building Information Modeling (BIM) software, I have seen many very proficient users of this software. Students and professionals take easily to SketchUp, and, before long, most of them produce very detailed building models and professional-grade renderings. But I have also found that too many people don’t go beyond the basics and believe that some of the advanced modeling (or good-quality photorealistic rendering) needs to be done using other software. Very often, they painstakingly pick up that other software only to find that it is too complex, which likewise leaves them unable to do what they wanted.

Sometimes even advanced users of SketchUp master one aspect of the software (photorealistic rendering, for example) but are completely unaware of the power that SketchUp holds in other areas—Dynamic Components and Ruby scripting are good examples. As you will find out in this book, SketchUp is a very powerful design and 3D modeling tool. Some of its core features—for example, its extendibility with extensions (these are sometimes also called plugins)—make it flexible enough to be useful for a variety of disciplines. The large number of high-quality extensions that are currently available for SketchUp bears powerful witness to this.

This book attempts to help the basic to intermediate user make the leap from simply creating “something” in SketchUp to using it as a powerful design tool. It also contains some more advanced topics (such as photorealistic rendering, Dynamic Components, BIM, and Ruby scripting) and provides a clear learning path that takes the reader through easy-to-follow examples to a thorough understanding of the core topics. Figure 1.1 shows an example of how you could use Ruby scripting to create geometry, then render the scene using photorealistic rendering software, and finally “dress up” the image as a watercolor painting.

About This Book

Each chapter in this book presents a different SketchUp use in sufficient detail to get you started and working quickly. Interspersed with the text are many step-by-step examples, tips, and in-depth articles. At the end of each chapter, you will also find a collection of activities that you can undertake to try out new skills that you just learned.
Chapter 2, which follows this introductory chapter, brings every reader up to speed. Its purpose as a “SketchUp Refresher” is to review most of the basic modeling techniques and teach good practices for 3D modeling and software use. While many readers will already have some knowledge of SketchUp through introductory books or video tutorials, this chapter encompasses enough variety to be useful for everyone, independent of their skill level. In addition to modeling, this chapter covers materials, program setup and user interface, custom templates, geo-based modeling, and plan-based modeling.

Chapter 3 uses SketchUp not only as a modeling tool but also as a tool to inform your designs. In this chapter, you will learn more ways to efficiently work with SketchUp and add data and design intelligence to your models. Examples of this are creating hierarchical, component-based models (e.g., for virtual construction), using Dynamic Components and parametric design, and working with SketchUp’s Classifier system. This chapter also lays out how SketchUp can fit into a BIM-based architectural design process.

Chapter 4 leads you into the wide field of SketchUp extensions and their uses. After an introductory section on finding and installing extensions, many individual extensions are discussed. Those small software add-ons to SketchUp provide tools for general modeling, such as drawing splines and lofting curves; tools for architectural design, such as stair making and wood framing; and tools for digital fabrication that will help you prepare your model for 2D and 3D digital printing and assembly. (See Figure 1.2 for an example of a fabricated SketchUp model.) Furthermore, there are extensions for data integration that can import or export data such as Laser Imaging, Detection and Ranging (LIDAR) laser-scan points; extensions for animation and
presentation that add object animation or serve as helpers for creating animations and walk-throughs using SketchUp; and, finally, extensions for analysis, which provide analytical tools—mainly from the field of building energy analysis and green building.

Chapter 5 introduces photorealistic rendering and covers all aspects of rendering in detail (see Figure 1.3 and Figure 1.4). This chapter was written to be as independent of your actual choice of rendering software as possible, thereby providing a useful resource no matter which software you end up getting. As part of this chapter, you will learn about modeling for rendering, lighting, sky environment, materials, and objects, as well as how to edit and modify renderings for final presentation using image-editing software.

Figure 1.2: Infrared photography house model made in SketchUp and physically built using extensions
Chapter 6 lays out how SketchUp can be used for digital fabrication. While SketchUp has always been used to fabricate buildings, this was typically accomplished with a manual process (employing workers) and analog intermediaries (construction documents). Digital
fabrication (as employed in cut preparation, 3D printing, laser cutting, CNC routing, etc.) uses the full precision that the computer provides from concept to final product. This approach offers many new and exciting possibilities (see Figure 1.5 for an example), and this chapter provides you with step-by-step instructions on how to use these techniques with SketchUp.

Figure 1.5: SketchUp’s CNC-cut WikiHouse pavilion for the 2013 New York Maker Faire (Used by permission of Trimble Navigation Ltd.)

The final chapter in this book (Chapter 7) introduces you to the exciting field of computational geometry in SketchUp. This chapter presents Ruby script examples that create undulating brick walls, solar-responsive facades, attractor-based colorful building designs, and other fun ways to create geometry in SketchUp without excessive use of the mouse (see Figure 1.1 or the paneling on the title cover for examples). Most of the script examples accomplish their tasks in just a few lines of code, and all are good introductions to both the Ruby scripting language and the general field of computational geometry.

Chapter 7 can also serve as a “learn to code” curriculum for young or adult readers. It introduces basic programming concepts and applies them in a way that yields 3D models. It should be quite exciting for the learner that the results from this approach can even be 3D printed and, therefore, turned into physical objects.

As you will see in the chapters that follow, this book is intended to serve as a textbook as well as a desk reference. It was written to convey the presented material in a thorough yet easy-to-follow manner. It also covers common tasks using a cookbook approach, which allows you to simply copy the procedure to get a satisfactory result or modify it according to your individual needs.
In addition to reading this book, keep checking its companion website, which features news, tutorials, links, videos, and downloads related to this book. You can also interact there with the author and other SketchUp users and discuss any issues you may run into. Web links will be frequently updated there, and new ones added as new software is released.

This book’s companion sites can be found here:

www.sketchupfordesign.com—Author’s interactive companion site.


3D for All

Because SketchUp is not domain-specific, it has found a following with professionals and enthusiasts from many disciplines. This is why you will find SketchUp mentioned in discussions not only by architects, landscape architects, urban planners, engineers, construction professionals, woodworkers, and timber framers but also by robot builders, artists, sculptors, model-plane builders, paper-plane builders, mapmakers, historians, 3D game developers, and movie set designers (just to mention a few).

The techniques in this book are applicable to a variety of disciplines. Although many examples come from architecture or construction, some are from other disciplines (e.g., landscape design and interior design). Whatever your background is, feel free to take the examples that are presented here and adapt them to your discipline. (See Figure 1.6 for a nontraditional use of SketchUp). The techniques you learn will be equally useful.

Taking this one step further, I can even say that I can’t think of anyone who should not be using SketchUp. Living in a three-dimensional world and dealing with three-dimensional objects, everyone has the need at some point to model and visualize virtually in three-dimensional space.

Consider this hypothetical situation: You want to build a deck in your backyard and need to explain to the builder how it should look. Another example is a scientist who needs to explain a lab setup in a presentation. Far too often we resort to 2D representations of our thoughts (the classic floor plan, for example), which leaves too much unknown and unexplorable.

Admittedly, many people are not trained in hand-sketching in 3D, which often leads to poor visualizations of things that can actually be quite interesting when presented properly. That is where SketchUp shines. Its 3D modeling capabilities and its ease of use make it a simple yet very powerful tool for anyone to give shape to their thoughts.
How Does SketchUp Fit into the Designer’s Toolbox?

As a professional or student, you likely already have assembled a sizable software “tool chest” by now. Depending on your discipline, this might include office software, CAD software, image-editing software, print layout software, analysis software (for energy or structural analysis, for example), coordination tools, and many others.

SketchUp fits into this collection very well. While the free SketchUp Make provides a complete 3D modeling tool set for the hobbyist, the commercial SketchUp Pro broadens this further by adding layout and documentation abilities and other professional-oriented tools, such as multiformat import/export and BIM capabilities.

Depending on your needs and knowledge of the software, you can use it as an early design tool—after all, as its name indicates, it was developed for 3D sketching. In that capacity, it shines by providing easy editing and immediate 3D visualization (see Figure 1.7)—something that can be very useful during quick design iterations.

You can also use it for the complete design process from initial stages to a finished product (whatever that may be—buildings, gadgets, etc.). For that case, it provides the capability to create precise, organized models that can contain any level of data. Those models can then be used as the basis for construction or production documents (with SketchUp Pro’s LayOut software) and/or be exported for digital-process-based fabrication, such as CNC routing.
SketchUp also works well with other software. 3D models from SketchUp can often be opened directly in those programs, making data exchange easy. Even if that isn’t available, SketchUp’s built-in file exchange options allow you to export a 3D model in a variety of formats. As shown in Figure 1.8, built-in services and extensions exist that connect SketchUp to online collaboration platforms where you can share your models with only a few clicks.
If SketchUp is already part of your tool set, then the best use of your time will be to expand on the skills you have developed already and deepen your knowledge of this software. This book provides you many avenues to do so.

Windows or Mac, Pro or Make?

SketchUp comes in a variety of flavors: While SketchUp Pro is the core commercial product, Trimble maintains (and has expressed its ongoing commitment to) a free “Make” version. Both are multiplatform software, which means they are available for both Windows and Mac computers. In addition, SketchUp has viewers for computers (both platforms), and Apple and Android tablets and phones.

The free version, SketchUp Make, is geared toward hobbyists, makers, and private 3D modelers. While it comes with a significant subset of the 3D modeling functionality included in the Pro version, its license limits it to noncommercial uses, and it does not include the LayOut presentation software. It is, however, capable of COLLADA and KMZ import/export, which is useful for makers, and it allows for installation of (most) extensions, including rendering applications.

The commercial version, SketchUp Pro, adds a variety of professional-oriented features:

- LayOut software for drawing-preparation and presentations
- Style Builder software for creating custom sketchy lines
- DWG/DXF import/export
- PDF, EPS, 3DS, IFC, FBX, OBJ, XSI, VRML export
- BIM classifier
- IFC import/export
- Component-based report-generation
- Dynamic Component authoring
- Solid Tools for Boolean modeling

Many of these features allow the professional SketchUp user to integrate it into their workflow by making it easier to exchange data with CAD software (such as Autodesk AutoCAD), BIM software (like Autodesk Revit), online collaboration platforms (like Trimble Connect), and presentation software (e.g., Adobe Illustrator). Modeling and workflow enhancements (such as the ability to create Dynamic Components) also provide the professional user with the capability to create and disseminate product-model databases that facilitate planning and estimating tasks.

LayOut, which comes with SketchUp Pro, has the ability to replace other drawing- and presentation-creation software, enabling you to keep that aspect of your workflow tightly aligned with SketchUp. 3D models created in SketchUp are always live-linked in LayOut so that updates propagate through the entire drawing set.

While the free Make version just requires a download, at the time of writing, the Pro version was priced at $590 (in the United States), which includes one year of upgrades and costs $95 per year thereafter. Both versions are currently available in a multitude of languages, which gives this software global reach. At this point, qualified students can get a time-limited
license to use SketchUp Pro for $49 (also U.S. pricing). You can find out more about these purchase options on their website: www.sketchup.com.

Depending on your needs, you have to decide which version is right for you. If you use SketchUp only for noncommercial projects or for training and you have no need for any of the aforementioned Pro features, then the Make version should suffice—the majority of this book’s content, such as photorealistic rendering, many extensions, and scripting, will work well with it. This book then offers a cost-efficient entry into relevant and current topics (such as 3D modeling, rendering, and computational geometry). If you, however, need the more advanced features and are planning on using SketchUp professionally, then your best approach is to get the Pro version right away.

This book was written to be applicable to both versions. However, when tools are discussed that are available only in the Pro version (e.g., creating a Dynamic Component or using Solid Tools), they are visually presented as a “Pro Only” section.

PRO ONLY

Pro Only sections look like this.

While all of this book’s illustrations have been created using the Windows version of SketchUp, the tasks and tutorials are similarly usable with the Mac version. Menus and dialogs generally look the same and are in the same location on both platforms. There are minor user-interface differences, but they are easy to figure out. Consult SketchUp’s help system if you run into trouble.

It is also a good idea to stay up to date with SketchUp. In addition to this book’s companion website, bookmark the following sites to help you with this:

www.sketchup.com—The official home of SketchUp. You can get the latest Make or Pro version here.
http://help.sketchup.com—SketchUp’s knowledge center. If you get stuck, go here first!
http://forums.sketchup.com—SketchUp’s user forums. Another great place to discuss problems and get help.
www.alexschreyer.net—My personal blog where I frequently post about SketchUp and other AEC software.
@alexschreyer—My Twitter handle under which I post news and links about SketchUp and AEC software.
How This Book Works

One way to use this book is linearly as a learning tool by moving from chapter to chapter. This method builds your skill set gradually and allows you to logically approach each subject.

You may also want to use it as a desk reference, or you might be interested only in individual chapters. In these cases, make use of the index and the appendices.

Some conventions in this book:

- Whenever I mention a window (e.g., the Materials window), this means the dialog window that can be accessed from SketchUp’s Window menu.

- Other dialogs that open when the user clicks on something are commonly called dialogs in the text.

- Menu locations are typically presented in this format: File → Open…

- Whenever a tool from the context menu is mentioned, remember that you need to position the mouse cursor above something to get the menu options that relate to this object’s context when you right-click.

- Any toolbars mentioned in the text can be opened from the View → Toolbars menu in SketchUp (or by right-clicking on any open toolbar). Extensions often install their own toolbars. They will, of course, not be available until a plugin has been installed.

- Many examples in this book use US-customary construction units such as the inch (”) or foot (’). If you don’t use these units, read the “Setting Units and Fonts” section in Chapter 2 and adjust the use of units in the examples to your unit system. SketchUp works well with any unit system.

- Following are some Mac-specific differences:
  - SketchUp’s preferences cannot be found under the Window menu item, but instead are under the SketchUp menu.
  - Toolbars are called tool palettes.
  - Instead of right-clicking to bring up the context menu, you can left-click the mouse while holding the Control key.
Let’s Go!

It’s time to explore the world in the third dimension. Enjoy your modeling endeavors!